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1. Introduction 
The Soil Moisture Logger is a small hand-held device for reading, displaying and storing data from up to 100 

gypsum block sensors. Models are available for reading different block types including Malvic and 

Watermark. Data for up to 100 blocks can be stored in the Logger, and transferred to a computer through 

the standard serial or "RS232" port. The computer program automatically assembles the data for each 

block and allows graphs and tables of results of soil moisture at various depths to be displayed and 

printed. If a computer is not available, the results collected from the blocks can be read from the liquid 

crystal display ("LCD") allowing users to transcribe results and draw their own graphs. 

Although the Logger can store readings from up to 100 blocks at once, there is no limit to the total number 

of blocks it can read. The computer program offers a "spreadsheet" presentation for up to 100 blocks, 

allowing you to specify the location and depth of each. If you are using more than 100 blocks, separate 

tables can be used to increase the capacity. After the memory contents have been read (either transferred 

to computer or transcribed manually), the Logger is ready for a new set of readings. 

When each block is read, the soil moisture tension is displayed in kilopascals (kPa). Wetter conditions 

produce lower readings. The block identification numbers are also shown on the display. The same block 

number is used for identification by the Logger program. In conjunction with the Logger's screen "menu", 

the three buttons allow you to select the identification number for each block, store its reading in memory 

and switch the Logger off. 

A 9-volt battery in the compartment in the rear of the case provides power. Battery life depends on use, 

but several months' operation could be expected. A warning message appears when the battery voltage is 

low. 

An interface cable is supplied to connect to the serial (RS232) port on a computer for transferring data. 

This cable is not needed in the field when reading moisture block values. 

2.   Installing Gypsum Blocks 
Gypsum blocks can only give proper indication of soil moisture if they are correctly installed. It is 

imperative that good contact is achieved and maintained between the surface of the blocks and the 

surrounding soil. In an ideal situation, each block would behave as if it were a part of the surrounding soil, 

absorbing water after rain or irrigation, and releasing it again as moisture content is reduced by 

evaporation and transpiration. It is also desirable that the soil structure should be disturbed as little as 

possible during installation. Rather than attempting to press the soil back firmly around the blocks to 

ensure contact, it is better to install them in silica flour. This material forms a flexible path between the 

blocks and the soil, and is particularly valuable in light sandy soils. In heavier conditions, good contact can 

often be achieved by placing the blocks in a slurry of the original soil, but silica flour is still recommended. 

WARNING - Avoid inhaling silica flour. Prolonged inhalation of the powder can cause silicosis. A dust mask 

should be worn. Dampen the powder in the bag to prevent the release of dust. Mix to a slurry for easy 

pouring around the block.  

At each location, gypsum blocks should be placed at various depths to adequately assess moisture 

conditions throughout the plant root zone. The region of interest depends on both plant and soil types. For 

turf, the range from 50mm to 300mm is adequate. For deeper-rooted plants such as trees, shrubs and 

vines, it might be necessary to install blocks as deep as 900 mm. Readings from a range of depths also 

indicates the speed of penetration of water, alerting you to soil compaction. 

Draw a complete plan of the gypsum block layout with the depths at which blocks are to be placed at the 

various sites.  Each block needs an identification number so that the logger can store the results correctly. 

For your own convenience, number the blocks now in the order in which they will be read. That is, 

block number 1 should be the first block that you will read, block number 2 the second, etc. 
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Preparing gypsum blocks: 
• Remove the foil packaging from the gypsum block.  

• Wet the blocks by soaking in water for about 15 minutes. 

To fit the blocks:  
Choose positions for the hole carefully - not too close to drippers or spray jets and not in furrows or 

hollows. 

Dig or bore a hole to the maximum depth at which the blocks will be buried, leaving a small amount of fine 

soil in the bottom of the hole. It is preferable to bore the hole with a soil auger as this minimises 

disturbance to the surrounding soil. If you don't have a soil auger, a small post hole digger might be the 

next choice. 

Light/Sandy soil: Place the block in the hole and pour in enough crushed silica to cover the block. 

Heavy soil: Crushed silica is again recommended as for sandy soils, but it is also sometimes satisfactory 

to embed blocks in a coating of mud from the hole. Place the coated block at the bottom of the hole, 

and pour a slurry of soil into the hole. 

• Label the end of the cable at a convenient height, and then fill up to the next depth with soil from the 

hole. It is best to replace the soil at the level from which it was excavated. Repeat the procedure for 

each block. Finish with a slight mound above ground level so that surface water runs away from the hole. 

• The cables should be tied off to a stake placed about 200mm from the hole. Strip the insulation from 

the ends of the leads. 

3. Using the Soil Moisture Logger 
When the Logger alone is switched on, it runs in the normal "field" mode to read and store soil moisture 

values from the blocks. However, when connected to a computer, the Logger switches to "PC" mode. 

Reading blocks and storing results  
• Clip the two leads to the wires on the block and press the On/Select button to start the Logger. The 

preset block type for your logger is indicated by an initial message on the LCD display. For example, 

“FFF Block” indicates that the logger is set to use Malvic blocks. Other block types may be set by the 

manufacturer. The standard model of the Logger can read only one block type. 

 

• Four menu items are then displayed on the LCD in a continuous cycle - Block No., Tension, Save 
Reading and Power Off. To select an item, wait until it is displayed, then press the Select button. If 

you do not press any buttons the Logger will turn off automatically after one minute. 

 

The Block No. is the present address (1 - 100) ie. the number of the memory address where the Tension 

value would be stored when you select Save Reading. Press the Next Block and Last Block buttons to 

change the displayed Block number. As you read and store the tension in turn from your blocks, the 

number you have given to each block on your layout plan should equal the Block No. number displayed. 

After a reading has been stored for any block, an asterisk (*) appears after that number to indicate that a 

reading has been stored for this block. 

The Tension label shows the value for the current block. The range of soil suction values depends on the 
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block type - Malvic gypsum blocks range from 1 to about 500 kPa and Watermark blocks range from 1 to 

200 kPa. HIGH values indicate DRY conditions. If no block is connected, or the tension is too high, "Dry" will 

be displayed. A very low impedance or short circuit across the block reads "Wet" (or a very low number). 

 

Save Reading is used to store the current moisture reading to the present Block No. (or memory address). 

If you press the Select button while this is displayed the reading will be saved and the message Saved in 
Memory will be shown for a short period.  

Power Off allows you to switch the Logger off when you have saved each reading. Again, the Select button 

does this. If you don't switch off at this point, the cycle of menu items will be repeated. 

After you have stored a reading and switched off the Logger, the Block No. is automatically stepped on to 

the next address, so that if you always visit sites in the correct numerical order, the logger will always be 

ready for the next block. However, to allow for reading blocks in a different order, the block number can 

be stepped forward by pressing the Next Block button, or back with the Last Block button. An asterisk (*) 

indicates that a reading has already been stored for the indicated Block No. and saving again to this 

address will replace the old reading.  

Unless you are sure that you want to replace the reading for a block, you should not save to a Block 
No. marked with an asterisk. 

Transferring readings to a computer 
Before you transfer data for the first time you must set up the site layout information – see Changing the 
Site Setup. 

After reading and storing the soil moisture values from each block, you can transfer the results to a 

computer for display, analysis and long-term filing. The computer software will keep track of all readings 

taken and every time the data in the logger is loaded into the computer, the readings are added to any 

previous results. Refer to Section 5 for details. 

Using Soil Moisture Logger data without a computer 
Although the best presentation of the Logger data can be obtained by transferring the results to a 

computer and then viewing the graph displays, you can also replay the data after taking all readings. By 

using the Next Block and Last Block keys, you could return to the beginning, and then step through all the 

results again, transcribing them at your leisure. You can then compile tables and graphs yourself.  

To manually clear a set of readings from memory, hold both the Next and Last buttons down together until 

the message Clear Data appears. Next time the logger is turned on, it will begin at block number 1, and no 

asterisks will appear until a new reading is saved for each block. 

4.   Computer system requirements 
Operating System : The Soil Moisture Logger program is designed to operate with Microsoft™ Windows 95, 

98, 2000, ME and XP.  

The following minimum specification is recommended: 

• A Pentium 90 MHz or better, 16 MB RAM, minimum VGA 800 X 600 resolution. 

• Floppy disk drive : For software installation and for regular backup of soil moisture data. 

• A hard disk with at least 4 MB free space is required. 

• At least one free RS232 (serial) communications port. If your computer does not have a serial port, then 

you may need a USB to serial adaptor. Contact Tain Electronics for information on the most suitable 

USB to serial adaptor for your computer. 
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5.   Computer Software Installation 

To install the computer software… 
1  Insert the Soil Moisture Logger installation disk in the floppy disk drive. 

2  Click the Start button and select Run... 

3  Type: "a:\setup" and click OK.  

4  If you have received the software by email, unzip the file to a temporary folder and double-click on the 

file setup.exe – this will start the software installation. 

Demonstration data and a sample block layout table file are supplied, so you can run the computer 

software with these immediately. The next section uses the demonstration data to describe the operation 

of the computer software. 

6.   Computer Software Operating Instructions 

To start the Soil Moisture Logger computer software… 
From the Start button, go to Programs and then find Tain Electronics in the next “fly out” list. Move right 

again and double click on the label Soil Moisture Logger Version 5.  

Viewing Data 

• After the title screen, the main menu will appear above a blank graph display. To move between menu 

items, use the mouse or the arrow keys. To select the chosen item, either click the left mouse button 

or press <Enter>.  

• A demonstration file is included to assist you with operation of the program. In the File menu, select 

Open Demonstration. A graph will appear showing artificial data for three blocks. A group of blocks at 

various depths in one shaft is called a “Site”. The first site here has been called “North Corner”. The 

results for all the blocks at various depths at a site are always shown together on one page. 
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• To see readings for other blocks, click on the View drop-down menu in the bar above the graph. Choose 

any other site name from the list and click to see its readings. 

 

 

• The graph initially shows the most recent data. To display earlier results, click on the left arrow symbol 

at the lower left corner of your screen. The right arrow symbol moves the display towards the latest 

readings. The graphs show steadily rising values corresponding to the soil drying out. The rapid drops 

would correspond to rain or irrigation. 

 

• The data on the graph is normally shown with both symbols and lines. You can turn off the drawing of 

symbols - just click on the Symbols check box (place the mouse cursor over the Symbols check box and 

click the left button).  

• The time span of the graph can be adjusted to show data for periods ranging from one week to two 

years. Click on the Show drop-down menu (in the tool bar above the graph) to select a different range. 

 

 

 

� Graph data pointer. The Logger program includes a feature called the graph data pointer that allows 

the user to quickly see the actual soil moisture values for a given day. Simply move the mouse cursor 

over the graph region and the mouse cursor will change to a cross hair and a blue vertical dotted line 

will appear on the closest day with soil moisture data. The soil moisture values for each block will be 

displayed in the legend above the graph. As you move the cross-hair pointer with mouse to the left or 

right the blue line will move to the next available set of data and update the values in the legend 

automatically. 
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Viewing results as tables 
Results can also be displayed as tables. There are two ways to display soil moisture data - show all of the 

readings for a particular site using the Site button, or show all readings for a particular day using the Day 

button. 

 

• When the Site table is selected, you can see data for a different site using the View drop-down menu. 

• When the Day table is selected, the most recent data is displayed. You can navigate to data for a 

different day using the First, Previous, Next and Last buttons (in the bar above the graph). 
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• The scroll bars on the screen can be used to move up and down the results display, as can the common 

keyboard functions (Up/Down Arrows, PgUp/PgDown). Ctrl-End can be used to move immediately to 

the end of the data, while Ctrl-Home can be used to return to the start. 

Setting up your Block Layout 
Before collecting readings from the gypsum blocks, you should enter your own layout table so that the 

program will be ready to display and store the results correctly. This only has to be done once, unless you 

install more blocks.  

If you are just starting to use the Soil Moisture Logger and computer, follow the procedure for Site Setup 

explained below. 

Entering a Site Setup 
The arrangement of blocks around your property is kept in a table in the Site Setup menu. A “site” in this 

table means a group of blocks at one location. Each site can have up to five blocks buried at various 

depths. In the graphs of readings, results from all the blocks at a site will be shown together.  

Important first step - enter your layout plan… 
A spreadsheet table will appear with spaces for up to 50 sites, and room for up to five blocks at various 

depths at each site. However, the table will not accept more than 100 blocks. For example, you could use 

two depths at each of the 50 sites.  

A name to identify the site setup table appears at the top. Change this from Property No. 1 to a name of 

your own choice. 

The first column allows a name for each site. 

Block ID numbers (1 to 100) and the depth for each (in cm) are entered in the body of the table. The 

choice of depths and the allocation of block numbers is entirely yours. You could, for example, enter the 

depth of the first (shallowest) block at each site in the “Depth 1” column, the next block in the “Depth 2” 

column and so on. On the other hand, you could use each column for a single depth. Each coloured trace 

on the graph would then correspond to a particular depth. Where no block is installed at a certain depth, 

that position would be left blank in the table. 

Use the mouse pointer to move around the table and then double click with the left button to edit any 

field. Make your entries in the appropriate boxes and then click OK. You don’t need to type in the block 

number each time. When you choose a vacant position, an Insert button appears. Click on this for 

automatic entry of the block number. The block depth from the position immediately above each cell will 

appear as you enter a new block, so very often you will not even have to type the depth in either. 

If you want to clear a block, double-click on the cell and then the Clear button. Note that this cannot be 

done once data has been recorded for the block, so you MUST set up this table before reading data from 

the logger.  

The Use Site Notes check-box allows information to be entered for each site with every set of readings. 

This is in addition to the single Comment accompanying each set of readings. For details of Site Note 

entry, refer to the sections Reading Data from the logger and Edit Data File. 

When the layout plan is complete, click OK to save it.  
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Changing the Site Setup 
To see the table of block arrangements used for the demonstration, select Site Setup in the Options 
menu.  

 

In this demonstration layout a total of twelve blocks have been set up at five sites. 

 

The computer software will allow a maximum of 100 blocks at up to 5 depths at any of 50 sites.  

To insert a block at a new position in the layout, double-click on a blank cell. The dialog below will 

appear. If you select Yes, a new block will be inserted at this location. The numbers of all blocks above 

the inserted block will be automatically changed. If you already have blocks in the ground then you 

must ensure that they are renumbered. You can print out the Site Setup table to assist with block 

numbering - just press the Print button. 
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To change an existing table entry, move the mouse pointer to the item and click the left mouse button 

once to select it. Double click to edit it. Site names and depths can be modified, however the computer 

software controls the assignment of block numbers. If the block does not have any data recorded against 

it, then you may modify the block details or remove the block with the Clear button. 

 

If the block already has some data recorded you will see the following dialog. 

 

If the block does not have any data recorded, then you will see the same dialog with a Clear button 

displayed. To remove a Block that does not have data from the layout, press the Clear button. 

To leave the Site Setup Dialog, Click on either the OK or Cancel button. (Changes to the demonstration 

layout table will not be saved.) 

• Use Close Demonstration in the File menu to clear the graph.  
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Reading data from the Logger 
Before data can be read from the logger for the first time make sure that your site layout has been 

created. 

To transfer the values from the logger, first connect the interface cable between the logger and the 

"RS232", "Serial" or "Com" port on your computer. 

 

 

• Click on the Read Logger button in the main menu.  

• As instructed by the message on the screen, press the Select button on the logger to switch it on, then 

click OK on the computer screen.  

 

The computer software will transfer the readings from the logger and show the results on the screen as a 

table of soil moisture readings.  

While displaying the data, the computer software normally will ask if you want to reset the logger. Click 

the Yes button at the top of the screen so that the logger memory will be cleared and ready for a new set 

of readings.  
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Adding a Comment to your Results 
After extracting the data, the program asks for a comment. If you wish, you can enter a brief message (up 

to 20 characters) to include any special information with the set of results. For example, rainfall or 

irrigation notes could be entered here. Only one general comment is allowed per day.  

 

Adjusting the Date of a set of readings 
The computer software will allow the date of the most recent set of readings to be adjusted. This option is 

useful if the day when you are downloading results to the PC and the data was collected on a different 

day. 

Click the Adjust Date button. A calendar dialog will then be shown. Select a different day by clicking on 

the day. If you select a day which is the same or before the date of the last set of soil moisture data you 

will receive a warning. Similarly, it is not possible to select a date that is later than the current date. If 

you need to change the month, click the up or down buttons next to the month. 

 

Using Site Notes 
The Logger program has an option that allows a note to be recorded for each individual site every time the 

logger is read. This is useful to note watering patterns, weather conditions or changes to the site. This 

option is switched on by going to Options, Site Setup. Click on the Use Site Notes checkbox - in the figure 

below the Site Notes option has been enabled. 
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After you read data from the logger a button called Site Notes will appear next to the Comment text box.  

 

 

Click on the Site Notes button and enter a note for any or all of the sites.  Click OK to return to the 

downloaded data table. Click Continue to see the data displayed as a graph. 

 

Merging two sets of readings taken on the same day 
It is usually not necessary to take soil moisture readings more frequently than a few times each week. 

However, if you do take more than one set of readings in the same day, the program has a special 

procedure to handle the data. It is possible either to keep ONLY the later set of readings OR to combine 

the two. 

(a) If you wish to combine the new set of results with the earlier set, then click on the Yes button. The 

computer software will then compare the two sets of readings. For each block that has been read, the 

computer software will allow you to select which value is to be kept. 

 

(b) To discard the first set of results and keep the second, click the No button. 
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Entering and modifying readings using the Data Editor 
The Logger computer software stores results from your soil moisture logger in data files on your hard disk.  

The Edit Data option may be used to perform the following functions : 

• enter data manually. For example, you may have soil moisture readings that were recorded before you 

started using the logger program. 

• modify soil moisture values for individual blocks. 

• add or modify Site Comments and Site Notes. 

• modify the date of a record. 

• delete data records. 

To start the Data Editor, select Edit Data in the Options menu. Results will be displayed for the most 

recently recorded results. To show results for a particular date you may use the First, Previous, Next and 

Last buttons.  

 

Another way to select a date is to press the Calendar button. To change the day, click on a day. To change 

the month or year, click on the up and down arrows. Press select to accept the date. If there are no results 

for the selected date, then the data table will disappear. Click on either the Previous or the Next button 

and the program will display results for the closest date that has results recorded. 
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Modifying Data 
To modify the data you may click on the Change button or double-click on the center of the table. 

A dialog will be displayed to allow you to select from the list of editing options.  

 

Once an editing option is selected the Save button will be displayed on the screen near the date. Once you 

have completed changes to the results you must click the Save button before you can view any other 

recorded data. 

Change soil moisture values 

 



 15 
 

 

Add New Results 
To add new results, select a date which does not have any results. Click the Change button. 

 

After entering or amending values, click on Save Changes. 

Delete Results 
To delete a set of readings, go to any cell in that set of readings and click Delete Record. A dialog box will 

appear that asks you to confirm deletion of the record. WARNING – this will delete the complete set of 

readings for that day. 

Edit Site Notes 
It is possible to change or add a note for each site within a set of readings. To be able do this, the Use Site 
Notes check box must first be enabled in the Site Setup item in the Options menu.  

In Edit Data, select any cell for a site of interest, click on the Change button, and then type your note in 

the Site Notes text box. Click on Save Changes. 
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Custom Views 
The graph display normally shows the soil moisture data for all blocks at a particular site. There is also a 

facility called Custom Views that allows you to group any combination of blocks from any site so that they 

can be displayed together on graphs and tables at the same time. Up to eight blocks may be placed into a 

custom view. For example, you may wish to compare all blocks at a particular depth. 

To add or change Custom Views, go to the Options menu, click Custom Views. 

The Edit Custom Views dialog will be displayed which lists all of the Sites with the block information. 

 

 

To create a custom view, click the New button, enter a name to describe this custom view (My Custom 

View in this example).  

To add blocks to the custom view, click on a block in the left window, then click the Add button or double-

click on the block. The selected block will be added to the list of blocks in the right hand side window. 

To remove a block from the Custom View, click on a block in the right side window, then click the Remove 

button. The block will be removed from the Custom View. 

Click OK once you have completed your changes. The new custom view will be automatically added to the 

view drop-down menu above the graph. 
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Explanation of other menu items 

File Menu 

Export Results 
The data collected by the program can easily be exported to other “Windows” programs, such as Excel or 

Word (as a table). When you click Export Results, three choices are offered.  

 

 

The first two options will produce data files suitable to be read by popular spreadsheets. Records in the 

files can be separated either by a comma or a tab. Tab is usually the most convenient for later versions of 

Excel. The third choice copies the graph to the clipboard for transfer to another program such as Word or 

an image editing program. 

Print and Printer Setup 
Both text results and graphs can be printed. The Print item does the same as the button on the bar above 

results display. Use Printer Setup to select the printer and modify paper size and page layout. 

Note that for black and white printers the colours to shades of grey. For clearest printing on black and 

white printers, turn on Symbols to help identify the different blocks on the graph. 

Options menu 

Invert Graph Scale 
The Soil Tension values on the graph normally increase from low kPa values (“Wet”) at the origin of the 

graph to higher tension values at the top. If you want the scale to rise from “Dry” to “Wet”, go to the 

Options menu and select Invert Graph Scale. 
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Mixed Block Types 
The standard model of the soil moisture logger is designed to read data from blocks that are all of the 

same type. Normally this option should not be selected. Some models of the soil moisture logger can be 

switched between two different block types. If you are using the special model of the logger, then select 

the Mixed Block Types option. This option will provide the facility to set the block types of the individual 

blocks in the layout table in Site Setup. 

Multiple Tables 
Each site setup table can accept up to 100 blocks to match the number of readings the logger can store at 

once (earlier models can hold only 30 or 50 readings). The Multiple Tables option should be selected if you 

have more than one property or you wish to record more block readings than the logger will allow. When 

this option is chosen, the program will allow you to enter one or more layout tables to accommodate the 

extra blocks. Go to the Options menu, Click on Multiple Tables. You will asked to confirm this change. 

Next go the File menu and click on Create New Table. The selection of Multiple Tables (from the Options 
menu) only needs to be performed once - once selected then any number of new tables can be created 

(from the File menu). 

Multiple Tables is also useful if you find it necessary to make major changes to your block layout. Once 

the site setup table has been entered and corresponding data recorded, it is not possible to delete blocks. 

New blocks may be added at any time. To make more extensive changes, create a new table. The earlier 

data and setup table is still available to be viewed but new readings should not be added to it. It would be 

best to edit the name of the earlier table to indicate that it is no longer in use (eg. “Records up to Mar 

2003”). Create a new table and give it a descriptive name to indicate that it is the current version. Then 

go to Options and Site Setup to enter your new site layout. 

When the computer software is started in future, a dialog will appear showing a list of available tables. 

Choose the new table to store the new readings - select the earlier table to go back and view historical 

data. 

Com Ports 
The interface cable from the logger is plugged into one of the computer’s serial communication ports. To 

change the Com Port setting, go to the Options Menu, click Com Ports. The fly out menu will show the 

currently selected option. The default setting is Auto – (COM1: / COM2:).  

When you click Read Logger, the computer software will automatically check the selected port(s) to look 

for the Soil Moisture Logger. For the Auto setting, both COM1: and COM2: will be checked at the same 

time. If other individual ports (COM1: to COM6:) are selected, then only the selected port will be opened.  
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Using a USB to Serial Adaptor with the Soil Moisture Logger software 
 

If you have a USB to serial adaptor, then you need to know which COM port it is using. 

Click the Windows Start button, Settings, Control Panel. Double Click on System 

The Windows System page will be shown. Click on the Device Manager Tab. 
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The System Properties dialog will be shown. Find the Ports (COM & LPT) item.  

Double-click on Ports (COM & LPT) to show more detail. 
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The USB to serial adaptor information will be shown. Take note of the Com port setting (in the example 

above, the ATEN USB to serial convertor has been installed as COM2: . 

Close the device manager window and start the Soil Moisture Logger software. Go to Options, Com Ports 
and select the Com Port to match that used by the USB to serial adaptor. 

Log File 
This is a fault finding diagnostic tool that is used to report communications to a data file and is not 

required for ordinary use. 

Backup data 
This option is used to make backup copies of your soil moisture data to floppy disk. A more detailed 

description is given in the next section.  

Restore Data 
This option is used to place (restore) the data saved in Backup Data onto a new or existing computer. For 

more information, see the next section Making Backup Copies of you Soil moisture results.  

Making Backup Copies of your Soil Moisture data 
It is important to regularly back up your soil moisture logger data. Data loss may occur if your hard disk 

fails or if there is a power failure at the time that the program is writing data to the hard disk.  

Automatic Backup 
To minimise the risk of data loss due to power failure or corruption of the files, the logger program 

automatically creates two backup copies of your logger data files just before data is read from the logger. 

These backup files are placed on the same hard disk as your original data. In the event of a file error when 

the computer software next opens your data file, the computer software will attempt to recover data from 

the previous automatic backup.  

Backup of data to floppy disk 
The automatic backup does not offer any protection if your hard disk were to fail, so you should make 

regular backups of your data to floppy disk. The Logger computer software will prompt you once a month 

to back up your soil moisture data files to a floppy disk. You may perform a back up more frequently if you 

wish by selecting Options - Backup Data. 

This is used for periodic saving (backing up) current data onto network or removable disks. There are two 

reasons to make regular backup copies of your data - security in case of computer malfunction and to 

provide a means of transferring all site information and data to a new or different computer system. To 

keep your data safe please use Backup regularly.  

It is recommended that you keep two or more removable disks as backup sets. Write the date of each 

backup on the disk label and next time you perform a backup use another removable disk. 
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